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Introduction

This booklet explains how to view the images you took with the
PENTAX Optio S4i on your PC. Keep this manual in a safe place.

Regarding copyrights

Images taken using the Optio S4i that are for anything other than personal
enjoyment cannot be used without permission according to the rights as
specified in the Copyright Act. Please take care, as there are even cases
where limitations are placed on taking pictures even for personal enjoyment
during demonstrations, industrial enterprise or as items for display. Images
taken with the purpose of obtaining copyrights also cannot be used outside
the scope of use of the copyright as laid out in the Copyright Act, and care
should be taken here also.

Regarding trademarks

The SD logo S is a trademark.

* PENTAX is a trademark of PENTAX Corporation.

Optio is a trademark of PENTAX Corporation.

All other brands or product names are trademarks or registered
trademarks of their respective companies.

Apple, the Apple logo, AppleScript, the Apple Store, Mac, the Mac logo,
Mac OS, Macintosh, and QuickTime are trademarks of Apple Computer,
Inc., registered in the U.S. and other countries.

This product supports PRINT Image Matching II.

When used in combination, PRINT Image Matching Il enables digital still
cameras, printers and software help photographers to produce images
more faithful to their intentions.

Copyright 2001 Seiko Epson Corporation. All Rights Reserved.

PRINT Image Matching is a trademark of Seiko Epson Corporation.
“PictBridge” allows the user to connect the printer and digital camera
directly, using the unified standard for the direct printout of images. You
can print images directly from the camera through a few simple operations.

Symbols used in this manual have the following meanings:

L=y Gives page numbers explaining related operations.

= Gives information that is useful to know.

Bcaior Gives cautions and notes about the operation.

The PC screenshots in this booklet may differ from your PC, depending on
your model.
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How to Use the Captured Images

Here are some ways to use the images captured with your digital camera.

Direct Print

Connect your camera and a printer that
is compatible with "PictBridge" directly
with the USB cable, and print images.

w=Camera Operating Manual (p.103)

Fiasidge

View images on a TV Is your computer...
. * equipped with a standard USB interface?
Connect your camera and TV with + using Windows 98/98 SE/Me/2000/XP as
the AV cable and display images your OS? Or Mac OS 9.0-9.2/10.1 or later?
on the TV.

Connect your camera
and computer with the
USB cable, and copy

the camera images.

|
Is your computer...
+ using Windows 95/NT,

Mac OS 8.6
Transfer your images using
Use your photo shop | a built-in card slot + PC card
adapter or a card reader.
Have prints made from your * Remove the card from the

card images at a photo shop.
» Set DPOF settings on your
camera, and get prints from

camera. When transferring
images on the cardtoa PC
with another device, make

your photo shop. sure to review the user
wwCamera Operating Manual manual accompanying
(p.100) that device.

« Select the images for prints.




I Use your image data ‘

Use your e-mail software to attach images to e-mails, or a
use them on your homepage.

» See the operating manual of your
e-mail software for details on how
to make attachments to e-mails.

 See the operating manual of the
software you are using for details on
how to use images on your
webpage.

”N

Use your printer

m) | ("ACDSee for PENTAX wp23-42
* View Images  Edit Images
+ Save processed images ¢ E-mail Images
q » Manipulate images * Printimages Print images from your
* These operations also can be performed computer to your printer.
using commercially available image editing Some printers can print
software. See the instructions provided with directly from cards.
the software for more details. « For details, see the

operating manual of the
printer you are using.

‘ Save your image data

Images sent to the computer can be
saved onto a CD-R or other media.




Viewing Digital Camera Images on a

Windows PC

You can use the provided USB cable (I-USB7) or a card reader to
transfer your digital camera’s images to the PC, and you can edit and
print your images using the image viewing software. Here, the
method for viewing images with the provided software (S-SW20) is
explained.

Software Provided

The following software is included in the CD-ROM (S-SW20)
provided.
+ USB driver
* Image viewing / editing software (ACDSee for PENTAX)
* QuickTime

System Requirements

o USB connection
* USB mass storage class
« USB 1.1
*+ OS: Windows 98 /98 SE / Me / 2000
Windows XP Home Edition / Professional
» USB port must be standard equipment

® Application Software
<ACDSee for PENTAX>
(9 languages: English, German, French, Spanish, Italian, Russian,
Chinese [traditional and simplified], Korean, Japanese)
+ OS: Windows 98 /98 SE/ Me /
NT (latest version) / 2000
Windows XP Home Edition / Professional
» CPU: Pentium or higher recommended
* Memory:64MB minimum
» Hard Disk space:40MB minimum



+ Display adapter capable of displaying a minimum of 256
colors
* Internet Explorer 4.0.2 or later
* Some formats may require viewing with QuickTime 6.0 or later and
DirectX 8.0 or later. C,
* To install ACDSee for PENTAX, Windows Installer Service
Version 2.0 may be required.

You can download DirectX and Windows Installer Service from
the following website.
http://www.microsoft.com/windows/directx
http://www.microsoft.com/windows2000/techinfo/
howitworks/management/installer.asp

<QuickTime>
(6 languages: English, German, French, Spanish, Italian, Japanese)
+ OS: Windows 98 /98 SE/ Me /
NT (latest version) / 2000
Windows XP Home Edition / Professional
« CPU: Pentium or higher recommended
* Memory:128MB minimum
* Operation is not guaranteed on all PCs meeting the system
requirements.

You may play moving pictures using the provided software
[ACDSee for PENTAX] (QuickTime 6.0 or later required).

M + The software cannot be used on Windows 95.
» We recommend using the AC Adapter D-AC5 (optional) when
connecting your camera to your PC. Your image data could be
corrupted if your batteries run out during image transfer.




Installing the Software

The procedures for installing the necessary software are explained.

_ OF:.

If you are using Windows 2000 or Windows XP, please login as an
administrator user before starting installation. Refer to your PC’s
operating manual for instructions on how to login.

Installing the USB Driver

1
2

Turn on your computer.

Insert the CD-ROM (S-SW20) into your CD-ROM drive.

The PENTAX Software Installer screen is displayed on the
desktop.

* When the PENTAX Software Installer screen is not displayed
Display the PENTAX Software Installer screen following the steps
below.

1) Double-click [My Computer] on the desktop.
2) Double-click the [CD-ROM Drive (S-SW20)] icon.
3) Double-click [Setup.exe].

Click your applicable
language.

You can choose the languages from
the displayed screen.

Francais ) EES )

A selection screen to install your Deutsch ) | _#3o )
desired software is displayed. e )RR )
Italiano )
Pycckruin ’

Click [USB Driver] on the
Software Installer screen.
The InstallShield Wizard screen will

English ) ACDSee™ )

appear. QuickTime™ )
Follow the instruction on the screen. [ _ussorver )|

Complete InstallShield Wizard T T
: Rt R )
screen will appear. Back ) | Ext )




5 click [Finish].
Reboot your computer after the screen closes.

6 Turn your camera off and plug the USB cable into your
camera and into an available USB port on your computer. (,

Confirm that the USB Connection mode is set to [PC] before
connecting the USB cable. (=p.9)

"memo

7 Turn your camera on.

Your computer will automatically detect the camera as new
hardware and window will display a notification confirming
[Hardware Found : PENTAX OPTIO S4i] (Windows XP) or [Search
for the best driver for your device (Recommended)] (Windows 98 /
98SE / Me / 2000) in the task bar recognized area to begin the
installation.

8 Double-click [My Computer] on the desktop.

When the installation is completed, your camera can then be found
in the [My Computer] window as [Removable Disk].

Make sure that “Removable Disk” is displayed in the [My computer]
window.

Lmemo In the case of Windows XP, if the SD Memory Card has a volume
label attached, the content of the volume label will be displayed
instead of [Removable Disk]. If the SD Memory Card is new and has
not been formatted, the manufacturer and capacity of the card may
be displayed.




Installing the image processing software (ACDSee for PENTAX)

This section describes the procedures for installing ACDSee for PENTAX
which lets you view and edit recorded images on your computer.

M If you are using Windows 2000 or Windows XP, please login as an
administrator user before starting installation. Refer to your PC’s
operating manual for instructions on how to login.
1 Tumn your computer on.
2 Insert the CD-ROM (S-SW20) into your CD-ROM drive.
The PENTAX Software Installer screen is displayed on the desktop.

¢ When the PENTAX Software Installer screen is not displayed
Display the PENTAX Software Installer screen following the steps below.
1) Double-click [My Computer] on the desktop.
2) Double-click the [CD-ROM drive (S-SW20)] icon.
3) Double-click [Setup.exe].

3 Click your applicable language.
You can choose the languages from the displayed screen.
A selection screen to install your desired software is displayed.
4 Click [ACDSee™].
The Setup screen will appear.
Follow the on-screen guidance and
enter the registration information.
Reboot your PC after installation is

e InstaliShield Wizard for
ack

finished.

* If QuickTime or later is not
already installed in your PC, a = /y\ s Gt oese
message suph as the one shown i coomercod ol o ol QuckTine o
on the right is displayed before
the Setup screen appears. Click —

[Install QuickTime] to first install ==
QuickTime.
" The panoramic image software “ACD Photostitcher”, the image layout

T and printing software “FotoSlate”, and the image editing software

“FotoCanvas” are also installed when you install ACDSee for PENTAX.




Product Registration on the Internet

Please click [Product Registration] on
the CD-ROM screen in step 4 on page 6
of this PC manual.

A world map for Internet Product
Registration is displayed.

If your PC is connected to the Internet,
click the displayed country or region and
then follow the instructions to register
your product.

Thank you very much for your cooperation.

&memo Only customers in displayed countries and regions can register their
products on the Internet Product Registration.

Copying Images to your PC

An explanation of how to display/copy images using ACDSee for
PENTAX is shown below.

Setting the USB Connection mode to [PC]

1  Press the MENU button.
The [ Rec. Mode] menu or the [=] Playback] menu will be
displayed.

2 Pressthe four-way controller (») to display [{i Set-up]
menu.



3  Use the four-way controller (A V)
to select [USB Connection].

4 Usethe four-way controller (< »)
Quick Button Green mode

D to select [PC] . USBComecton« . PC . »
5 Press the OK button. @END) Exit @®OK

[0 [ «Ji Set-up
Video Out NTSC
SleepTimeout 1 min
AutoPowerOff 3 min
Custom Function - EVCompensation

Copying Images to your PC
1 Tum your computer on.

2 Turn your camera off and connect it to the PC with the
USB cable.

Confirm that the SD Memory Card is inserted in the camera when
the images in the SD Memory Card are copied.

<

“

o

3 Turn your camera on.
The Device Detector screen is displayed automatically.
If the Device Detector screen is not displayed, display / copy the
images following the steps in “When the Device Detector screen is
not displayed” on page 12.




Confirm that [Copy images to
hard drive] and [Launch
ACDSee] are checked, and P
click [Next]. e

I~ Always do these actions

Youinserted a memary card.
Select what you would ke 10 do.

Click [Browse].
The [Browse For Folder] screen is
displayed.

Create folderin:

I Mi Fictures

T Delete images fiom memory card after copying them

Select a destination folder and 2
click [OK]. Select a destination folder

Deskiop
=12y My Documents
(1 adobe
0y eBooks
; (2] My Pictures
43 My Computer
My Network Places

Folder:

Carcel |t Fodr

Y

Click [Next].

Chrne. ]

I Dielete images from memory card after copying them

The image is copied to the PC, and
the ACDSee for PENTAX Browser
starts.




_ @

When the Device Detector screen is not displayed

4 Double-lick the [ACDSee for
PENTAX] icon on the desktop.

AzDZee for
PEMNTAX

S Double-click [My Computer].

6 Double-click [Removable Disk] =

(If the SD Memory Card has a |+
volume label name, then select
that name).

e

7 Double-click the [DCIM] folder.

8 Click the [xxxPENTX] folder.

(xxx is a 3-digit number.)




9 Sselect [Copy To...] from the
[Edit] menu.
The Copy Files screen is displayed.

10 click [More>>] and select the 20
destination folder. =

[askc

[MGPO001 oo I Skip whenidentical

11 Click [OK].
The image is copied to the PC.




Disconnecting the Camera from your PC

_ @

The computer is downloading the camera’s image data with the
camera is connected to the computer and the camera flash status
lamp (green) is flashing. Image data may be damaged if you
disconnect the camera during such conditions.

Windows 2000 / Me

1

"memo

Double-click the [Unplug or
eject hardware] icon in the task
bar recognized area.

The [Remove Hardware] screen will appear. Unplug or eiect hardware | Eiect rdnare
Confirm that [PENTAX USB 5l
DISK Device] is selected and i€, s cuming o oo or
click [Stop].

The [Stop Hardware Device] screen
will appear.

FENT. LISB DISK Device at PENTAX OFTIO S41

I Display deviee componerts

¥ Show Unplug/E jecticon onthe taskbar Close

Confirm that [PENTAX USB
DISK Device] is selected and
click [OK].

A message will appear.

ped, Choose O o cantinue.

dows wil atempt o stop the Folloning devices After the devices are.
hey map be afely.

Click [OK].

Disconnect the USB cable
from your camera and PC.

If the camera (removable disc) is being used by an application such
as ACDSee, the camera cannot be disconnected until the
application is closed.

In the event that an error message is displayed in Step 4, confirm that
the viewfinder lamp is not blinking and then disconnect the camera.



Windows XP

1 Double-click the [Safely
Remove Hardware] icon in the

task bar recognized area.
2 Click [PENTAX USB DISK £ safely Remove Hardware PX

compuer,

Device] and click [Stop] (@ Sttt dnssouuttoeshor et sdonclo S

FENTAX USB DISK Device at PENTAX OPTIO 541

Fropertes Siop
[ Display devics components
3 cClick [PENTAX USB DISK  Stop aHardvare device @d
Devi ce] an d c | ic k [o K] Confim devices to be stopped, Choose OK to confinue
Windows illtempt to stop th folowing devioss. e the devicss are

stopped they may be removed safsy.

e PENTAX DIGITAL_CAMERA USB Device

4 Whena message is displayed
permitting removal, turn the
camera off and disconnect the
USB cable from your camera
and PC.

Windows 98 / 98 SE

There is no hot plug icon in Windows 98 / 98 SE. Confirm that the
viewfinder lamp is not blinking before disconnecting the camera,
simply turn off the camera and disconnect the USB cable.




Viewing Digital Camera Images on a

Macintosh

You can use the provided USB cable (I-USB7) or a card reader to
transfer your digital camera’s images to the Mac, and you can edit
and print your images using the image viewing/editing software.
Here, the method for viewing images with the provided software
(S-SW20) is explained.

D Software Provided

The following software is included in the CD-ROM (S-SW20) provided.
* Image viewing / editing software (ACDSee for PENTAX)
« USB driver

System Requirements

o USB connection
* USB mass storage class
+ USB 1.1
+ OS: Mac OS 8.6 or higher
+ Installation of the driver is necessary for Mac OS 8.6

® Application Software
<ACDSee for PENTAX and ACD Photostitcher>
(6 languages: English, German, French, Spanish, Italian, Japanese)
*+ OS: Mac OS 8.6 or higher
(requires the latest version of CarbonLib)
+ CPU: Power Macintosh 266MHz or higher
* Memory:8MB minimum
» Hard Disk space:6MB minimum
* QuickTime 4.0 or higher

® Moving Pictures
* AVI (Motion JPEG) compliant
* You may play moving pictures taken using the provided
software [ACDSee for PENTAX] (QuickTime required).

m We recommend using the AC Adapter D-AC8 (optional) when

connecting your camera to your PC. Your image data could be

corrupted if your batteries run out during image transfer.



Installing the Software
Installing the USB driver (Mac OS 8.6 only)

Turn on your Macintosh.

Insert the CD-ROM (S-SW20) into your Mac’s CD-ROM
drive.

Double-click the [CD-ROM (S-SW20)] icon.

Double-click the [Install ACDSee] icon. (,

The PENTAX Software Installer screen will appear.
Double-click the [Master Installer] icon to display [PENTAX
Software Installer] screen.

5 click your applicable

AW N=

PENTAX " sottware nstaer

language. ‘

You can choose the languages from | — .
English

the displayed screen.

A selection screen to install your Deutsch )

desired software is displayed. ST

Italiano

6 Click your applicable Mac OS.
The software selection screen will : g .
appear. . — —

Mac OS 9
Mac 0S X )

Back )  Exit )




7  Click [USB Driver].

The USB driver will be installed.
When installation is completed,

PENTAX" sonare nstater

. English ) ACDSee™ )

reboot your Macintosh. Mac 0S 8.6 ) __ACD photostitcher )
| USB Driver ) |

Product Registration D)

Back )  Exit )

D Installing ACDSee for PENTAX

This section describes the procedures for installing ACDSee for
PENTAX which lets you view and edit recorded images on your

computer.

1 Tum your Macintosh on.

2 Insert the CD-ROM (S-SW20) in the CD-ROM drive.
3 Double-click the CD-ROM (S-SW20) icon.

4 Double-click the [Install ACDSee™] icon.

The PENTAX Software Installer screen will appear.
Double-click the [Master Installer] icon to display [PENTAX
Software Installer] screen.

5 click your applicable
language.
You can choose the languages from
the displayed screen.
A selection screen to install your
desired software is displayed.

PENTAX" sotware ntater

Francais )
Deutsch
Espafiol
Italiano )
HAE )




%

memo

Click your applicable Mac OS.
The software selection screen will

PENTAX" sotare nstaer

appear.

English )| Macoss.e )

Mac OS 9
Mac 0S X
Back ) Exit )
Click [ACDSee™]. PoENTAK

The setup screen will appear.
Follow the on-screen guidance to
input registration information and Mac0S9 ) —ACOpromSReT )
install the software.

English )| _Acpsee™ )

Product Registration >)

Back )  Exit )

If the message [CarbonLib-xxxxx could not be found] is displayed
during installation, you must add the function expansion file called
“CarbonLib” to the function expansion folder in the system folder in
order to install the provided software in Mac OS 8.6 - 9.2.

This error message is appeared when this function expansion file is
not present or when an old version of the file is present.

The latest version of the Carbon Lib is available on the Apple
website. Download the file and then install it onto Mac OS.

Apple website: http://www.Apple.com

*Contact Apple for detailed information on how to use CarbonLib.




Installing ACD Photostitcher

This section describes the procedures for installing ACD
Photostitcher which lets you join a number of images together to
form a panorama picture.

1 Double-click
[ACD Photostitcher].

The licensing agreement will appear | cyw ) _scoseer )

D on the screen. When you have read vec 05 80 )| _acophotostcner___)
it, click [Agree] to accept the terms of e
the agreement. Product Registraion )

Back )  Exit J
2 Choose a destination for the 5
software and click [Install].

Installation starts. When the
message appears telling you that
the software has been successfully
installed, click [Quit].

Product Registration on the Internet

Please click [Product Registration] on
the CD-ROM screen in step 7 on page
19 of this PC manual.

A world map for Internet Product
Registration is displayed.

If your PC is connected to the Internet,
click the displayed country or region and then follow the instructions
to register your product.

Thank you very much for your cooperation.

| ot Only customers in displayed countries and regions can register their
products on the Internet Product Registration.




Copying Images to your Macintosh

Setting the USB Connection mode to [PC]

1 Press the MENU button.

The [ Rec. Mode] menu or the [[=] Playback] menu will be
displayed.

2 Pressthe four-way controller (») to display [{i Set-up]
menu. (,
3 Use the four-way controller (A V) RIS
to select [USB Connection]. Video Out
4 Usethe four-way controller (<4 ») CispmFundon ECrprein
to select [PC] . < Greenmade
5 Press the OK button. E0Exit ®OK

Displaying images on your Macintosh
1 Tum your Macintosh on.

2 Tumn your camera off and connect it to the Macintosh
with the USB cable.

Confirm that the SD Memory Card is inserted in the camera when
the images in the SD Memory Card are displayed.




3 Tumn your camera on.

The camera is recognized as [untitled] ((NO_NAME] in
Mac OS X) on the desktop. The folder name can be @
changed. untitled

4 Double-click the [ACDSee™] folder on the desktop.

5 Double-click the [ACDSee ™] program icon.
An image list (Browser) is displayed.

6 Open the camera folder.

D The camera images are in the [untitled] (or volume label name if

the SD Memory Card has one) — [DCIM] — [XXXPENTX] (XXX is
a three-digit number) folder.
An image list of the camera is displayed.

7 Select the image to view from the image list.

Double-click the image you selected. A full-size image is displayed
(Viewer).

¥ If the SD Memory Card has a volume label, the volume label name
will be displayed instead of “untitled”. A new SD Memory Card
unformatted may show the manufacturer name or model number.

Copying images to your Macintosh

See your Macintosh user’s manual for how to copy or move files.
Please copy images to your Macintosh before editing them.

Disconnecting the Camera from your Macintosh

1 Drag [untitled] (or the volume label name on the SD
Memory Card) to your trash.

2 Disconnect the USB cable from your camera and your
Macintosh.




About ACDSee for PENTAX

“ACDSee for PENTAX” is an integrated software package that acquires,
organizes, displays, processes and shares digital camera images.

You can use the Browser (==p.24) to acquire digital camera images
efficiently. You then can organize them in your favorite way and even
display them as thumbnails.

You can use the Viewer (==p.31) to view a large version of a single image.

Further, when you install “ACDSee for PENTAX” which is on the
provided CD-ROM (S-SW20) on a Windows PC, the panoramic
image software “ACD Photostitcher’(s=p.33), the image layout
software “FotoSlate”, and the image editing software “FotoCanvas”
are also installed at the same time.

Use this software to enjoy an even higher degree of freedom in your
image creation, editing and processing.

This manual provides explanations regarding the most basic (,
“ACDSee for PENTAX” functions. Refer to the Help section in
“ACDSee for PENTAX” for detailed information.

Launching ACDSee for PENTAX

For Windows

1 Double-click the [ACDSee for PENTAX] icon on the
desktop.
ACDSee for PENTAX will launch and an image list (Browser) will
be displayed.

For Macintosh

Double-click the [ACDSee for PENTAX] folder on the
desktop.

2 Double<lick the [ACDSee for PENTAX] program icon.
ACDSee for PENTAX will launch and an image list (Browser) will
be displayed.

To exit ACDSee for PENTAX

Select [Exit] from the [File] menu in the Browser or the Viewer.




Viewing Using the Browser

In “ACDSee for PENTAX”, you can view images using either the
Browser, which displays a list of images, or the Viewer, which
displays one image at a time.
The Browser is displayed when you launch “ACDSee for PENTAX.”

About the Browser

Here, explanations are provided regarding Browser configuration as
well as names and functions within the Browser.

For Windows

i ACDSee for PENTAX - LOOPENTX.
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® Menu bar

You can select and execute the various functions and settings of the
ACDSee for PENTAX by choosing the menu items from the menu

bar.



@ Browser toolbar

Browser toolbar includes shortcut buttons for commonly used
functions and tools. These buttons open dialog boxes or display
further activity buttons.

You can customize the toolbar for easy use by turning the button
labels on or off, adding or removing buttons, and changing the size
of the buttons.

® Navigation pane

Navigation pane displays a folder tree of the folders on your
computer, extra drive, or peripheral device.

Navigation pane includes the Folders, Calendar, Categories, Photo
Discs, and Albums tabs. You can select these tabs to display their
respective contents in the File pane, or to organize your files and
folders.

@ Preview pane
Preview pane displays the image selected in the File pane.

®File list toolbar

With these shortcut buttons, you can move or delete items, select C_
what file types or folders to display in the File pane, and sort your

images.

You can customize the toolbar for easy use by turning the button

labels on or off, adding or removing buttons, and changing the size

of the buttons.

® Path box
Path box describes the location of the folder of images currently
displayed in the File pane.

@File pane

File pane displays the contents of a folder selected in the Navigation
pane as a list of files or as thumbnails.

You can sort your images by such criteria as file name, file extension,
file size, file date, etc.

Status bar
Status bar displays information and properties for the selected
folder, file or files.

T When these categories are not displayed, check ([~ ) the categories
you want to display in the [View] menu.



For Macintosh

®—'a File Edit View Image Media Tools Windows Help
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® Menu bar

You can select and execute the various functions and settings of the
ACDSee for PENTAX by choosing the menu items from the menu
bar.

@ Browser toolbar

Browser toolbar includes shortcut buttons for commonly used
functions and tools. These buttons open dialog boxes or display
further activity buttons.

@ Navigation pane
Navigation pane displays a folder tree of the folders on your
computer, extra drive, or peripheral device.

@ Preview pane
Preview pane displays the image selected in the File pane.



®File pane

File pane displays the contents of a folder selected in the Navigation
pane as a list of files or as thumbnails.

You can sort your images by such criteria as file name, file size, file
date, etc.

Changing the Browser display method

You can select any of the following 6 methods to display lists of
images in the Browser.

Select [Mode] in the [View] menu and then select a display method
from the submenu. You can choose from the following display
methods.

Thumb+Details
Display image file thumbnails and file information in a list format.
You can change the file information that is displayed. (=p.30)

Thumbnails C_

Display image file thumbnails.

Large Icons
Display large icons and file names.

Small Icons
Display small icons and file names.

List
Display small icons and file names in a list format.

Details
Display small icons and file information in a list format.
You can change file information that is displayed. (=p.30)




Viewing Images in Other Folders

To view images stored in other folders, select a folder from the folder
tree in the Browser Navigation pane or directly specify a folder in the
path box.

Selecting a different folder in the folder tree

Folders selected from the folder tree are designated as the current
folder and images from that folder are displayed in the File pane.

To display a subfolder

is displayed next to the folder icon of folders that contain
subfolders. Click [+] to display the subfolders. [-] is displayed next to
folders when subfolders are displayed. Click [<] to hide the subfolders.

Use the buttons on the Browser toolbar to select a
‘) different folder.

You can view the contents of the folder one level above the current
folder by clicking in the Browser toolbar.

You can view the contents of the folder displayed prior to the current
folder by clicking in the Browser toolbar.

Click [ to return to the folder displayed before you used [& in the
Browser toolbar to change the displayed folder.

Specifying a different folder using the Path box

Select [Path Box] from the [View] menu to display the path box in the
File pane. Directly enter in the path box the path of the folder
containing images you want to view. Images in that folder are
displayed in the File pane.

Also, click = to the right of the path box to display a dropdown list
containing a history of recently used folders. Select from the list a
folder with images you want to view. Images from that folder are
displayed in the File pane.




Sorting Image Files

You can change the order of image files displayed in the File pane.

Selecting sort categories

Select [Sort] from the [View] menu and then select a sort key
category from the submenu.

You can choose from the following categories.

Extension, Name, Size, Type, Date, Image Properties, Description

Specifying ascending / descending order

Select [Sort] from the [View] menu and then select [Forward] or
[Reverse] from the submenu.

L

—~ Clicking the right mouse button on the File pane background

(empty area where images are not displayed as thumbnails or

icons) will display the menu in the location of the cursor. You can

use the same step to rearrange the menus. C_
* For Macintosh, you can choose from the following categories: File

Name, File Size, Image Type, Date and Reverse Sort Order.

Sorting using the keyboard

You also can sort image files and specify ascending / descending
order using the numeric keypad on the keyboard.

0: Extension 4:Date
1: Name 5: Image Properties
2: Size 6: Description
3: Type +: Forward
—: Reverse

Enable NumLock by pressing the NumLock key on the keyboard
when you want to sort using the numeric keypad.




Setting Detailed Display Categories

You can specify items displayed in the list as well as change the
category order when the File pane is set to Details display.

Settings display categories

Select [Columns] from the [View] menu and then select a display
category from the submenu.

You can choose the following categories from the submenu.
Size, Type, Date, Image Properties, Description

Select another categories to remove checks when you do not want
to display details.
¥

o Clicking the right mouse button on the file list row header (portion

where name, size, and other categories are written) will display the
menu. You can use the same step to set the display categories.

Adjusting the width of display category rows

You can adjust the row width to match the amount of text for each
item displayed in the list. Align the cursor with the edge of the row
header. Click on the edge when the cursor changes to a left-right
arrow head and drag the edge to adjust the row width.

ot Double-clicking the left mouse button on the row header separator
will automatically adjust the row width to match the length of the list
text.



Viewing a Large Version of an Image

(Viewer)

Double-click on a single image file selected in the Browser to display
a full-screen view of that image.

About the Viewer

Here, explanations are provided regarding Viewer configuration as
well as names and functions within the Viewer.
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® Menu bar

You can select and execute the various functions and settings of the
ACDSee for PENTAX by choosing the menu items from the menu
bar.



@ Viewer toolbar

Viewer toolbar includes shortcut buttons for commonly used
functions and tools such as the Zoom tools.

You can customize the toolbar for easy use by turning the button
labels on or off, adding or removing buttons, and changing the size
of the buttons.

@ Viewer pane
Viewer pane displays your images one at a time in full resolution.

@ Status bar
Status bar displays information and properties for the selected
folder, file or files.

| ot When the viewer is displayed, you can close the viewer and switch
to the browser by performing any of the following.
+ Click the x| (close) button.
» Double-click on the viewer pane border.

* Press the [Esc] key on the keyboard.



Panorama Image Stitching with ACD

Photostitcher

With ACD photostitcher installed on a Windows PC, you can
panorama stitch the images you took in Panorama Assist mode.
The folder and image names displayed on the explanatory
screenshots will differ according to the setup of your PC.

m « If you are using Windows 2000 or Windows XP, please login as an
administrator user before starting installation.
« Install ACD Photostitcher and ACDSee for PENTAX separately
when using a Macintosh.
» Panorama stitching cannot be performed on images of varying
save sizes.

Panorama Image Stitching on a Windows PC

1 Run ACDSee for PENTAX.
An image list is displayed.
2 select the images for panorama stitching from the
image list.
Press the [Ctrl] key on the keyboard while clicking on pictures to
select multiple images.
After selecting the images, select [Extras] from the [Activities]
menu, and select [PhotoStitcher] from the submenu.
The [ACD Photostitcher] is not enabled if two or more images are
not selected. C,

Select images




3 Correct the image positioning.
ACD photostitcher starts, and the selected images are displayed in
panorama format.
Move the mouse pointer onto the image. It changes into a { symbol.
Hold down the left mouse button and drag the images to adjust the
stitching position.
When the position is adjusted, click the [STITCH] button.

2 Click the
[STITCH] button.

2 AcD ot
24.7%

1 Click and drag to
adjust position.

gl
images  |FA]

3images, 1212 by 840

4 select the stitching method.
You can choose the stitching method from [Big Plane] and [Cylinder].
Here, you will create a flat panorama. Click the [Big Plane] button.
A confirmation message is displayed. Click [OK].

EE—— x
er co

Click [Big Plane].

Focal Length [35 mm
I~ 360 degree

Image Size ding
& Small © Gradual
€ Medium  Steep
© Large < None

Background Color [ Jwhite =] _Cancel

x * Click [OK] and continue if a screen like
@ P S o the one shown left is displayed.




Trim the image.

Move the mouse pointer onto animage. It changes into a  symbol.
Hold down the left mouse button and drag the dotted lines to adjust
the image trimming position.

When the position is adjusted, click the [Trimming] button.

% ACD photostitch

= 2 Click the [Trimming]
button.

—— 1 Trim the image.

Save the image.

After confirming your trimming, click the [Save] button to save the
image. To cancel the trimming, click the [Cancel Trimming] button.
When you are done, close ACD photostitcher.

12 ACD photostitcher - Panoramic Image Viewer - 789 % 205

=lox]

(-2 )18 1=+— [Save] button

= [Cancel Trimming] button




Panorama Image Stitching on a Macintosh

1  Run ACD Photostitcher.

2  Click the [Load] button.
The folder selection screen is displayed.

3  Select the folder for panorama stitching, and then click
the [Choose] button.
The image files in the selected folder are displayed.

4 select all the images for panorama stitching and then
click the arrow on the right.

The selected images are displayed on the image layout palette in
the alignment window.

E—

Stitching method
button

5 Setting the stitching parameters.
D Click the Stitching method button to open the stitching parameter
selection window.
You can choose the stitching method from [Big Plane] and
[Cylinder]. Here, you will create a flat panorama. Choose the [Big
Plane] button and click [OK].




Check settings (%)

Select the panorama mode

v P e N

| T
Big Plane oylinder

D currentposition Focal lenati[ 35 Jom
stitching
[ 360 degres panorama

Select the image size

®small O Medium Q) Large

Select the blending
® Gradual QSteep (3 None

Select the background color
[Jwhite *

6 Click the [Automatic alignment] button.
The selected images are displayed in panorama format.

7 Correct the image positioning.
Click the image you want to move and display it in a red frame.
Hold down the mouse button and drag the image to adjust the
stitching position.
For easier adjustment of two images that are next to each other,

click the [Align 2 images] tab to enlarge the section where the
images overlap.

fi————— A ————————————

1 fossimases obe sttcned ? 9 fgustinepositonof th stiching mage
¥
© iGroo0z G 3
|+ IMGP0003.IPG >
e DR T Hold down the mouse
n button to adjust the
<) - _El stitching position.

8 click the [Stitch] button.
Stitching starts. When finished, the stitched picture is displayed.




10

Trim the image.

Click the [Trim] button to display the dotted lines around the image.
Move the mouse pointer onto the dotted lines. It changes intoa t
symbol. Hold down the mouse button and drag the dotted lines to
adjust the image trimming position.

When the position is adjusted, click the [Trim] button again.

To cancel the trimming, click the [Undo] button.

After confirming your trimming, click [OK].

; = Stitching result 781 x 212 (746 x 184) : 1 CIICk the [Trlm] button_
G 3 Click the [Trim] button.
V' A5) (%5 )— 4 Click the [OK] button.

—— 2 Trim the image.

SEDT

Zoom ratio: [ Display whole image | & I K10
Save the image.

Click the [Save] button to save the image.
When you are done, close ACD photostitcher.

Zoom atio: [ Display whole image | 2] KD




Printing an Image

You can print image files from the Browser or the Viewer.

Printing from the Browser

You can print images from the Browser.

1 Select one or more images.

To print several images, hold the [Ctrl] key on the keyboard while
clicking on all the pictures you want to print.

2 Sselect [Print Images] from the [File] menu.
The Print dialog box is displayed.

3 Selector change the printing options.

4  Click [Print].

Printing from the Viewer

You can print the currently viewed image, or all images that reside in
the same folder as the currently viewed image.

1 select [Print Image] from the [File] menu to print the
currently viewed image.

or

Select [Print All Images] to print all images in the same
folder.

The Print dialog box is displayed.

Select or change the printing options.

Click [Print].

WiN




To insert the date and print images

You can insert the date into an image file
and print it. Date insertion settings are
done in the Print dialog box.

1 Select the [Caption] tab in the
Print dialog box.

2 Checkthe [Printimage capture
date in the corner of images]
check box.

Creating and Printing Contact Sheets

You can create and print contact sheets (thumbnails) of yourimages.
You can add captions to each image, page headers and footers, and
control thumbnails size.

1 Inthe Browser, select a group of images.

Hold the [Ctrl] key on the keyboard while clicking on all the pictures
you want to print.

2 Sselect [Print Contact Sheet] from the [File] menu.
The Print Contact Sheet dialog box is displayed.

3 selector change the printing options.
4 Click [OK].

T~ For more information about creating and printing contact sheets,
D click the Help button in the Print Contact Sheet dialog box.




E-mailing your Images from ACDSee for

PENTAX

You can send images directly from the ACDSee for PENTAX without
using an external e-mail application. Image files are converted to
JPEG format then attached to an e-mail and sent. Images are
compressed before transmission when the file size is large but no
changes are made to the original image.

E-mail account setup is required before e-mailing images. See the
ACDSee for PENTAX Help section for details.

E-mail function of ACDSee for PENTAX is not compatible with
Macintosh.

1 Inthe Browser, select an 1
image or a group of images. ;
To select several images, hold the “’
[Ctrl] key on the keyboard while
clicking on all the pictures you want o

BB LC

to send. j
2 Select [Share] from the [ ] r
. agn e e st e | |
[Activities] menu, then select
[E-mail].

The Send E-mail dialog box is displayed.
3 Input the required information.

4 Click [Send].

For more information about e-mailing your images, click the Help
button in the Send E-mail dialog box.

:ﬁm\o An error message may be displayed and you may not be able to
~="send mail if your mail server security is set to a high level.




About ACDInTouch

ACDInTouch is a service that provides the latest information about
ACDSee for PENTAX using the Internet. You can access the latest
news and TIPS as well as information related to special offers, free
digital imaging resources and more.

To connect to ACDInTouch

1 Select [ACDInTouch] from the [Help] menu.
The Connect to ACDInTouch dialog box is displayed.
2 Click [Connect Now].

About the ACDInTouch services

ACDInTouch is a data exchange service. When you connect,
information is sent to you so that you can read up-to-date information
directly in the ACDInTouch pane. This information is relevant to your
product, such as upgrades, add-ons and related software from ACD
Systems that may also be of interest to you.

For information on ACD Systems’ Privacy Policy, visit Web site at:

http://www.ACDSYSTEMS.com/english/company/privacy.htm
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